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COMPUTER FUNDAMENTALS MCQs 

1. UNIVAC is 

A) Universal Automatic Computer 

B) Universal Array Computer 

C) Unique Automatic Computer 

D) Unvalued Automatic Computer 

Ans : A ( Universal Automatic Computer  

 

2. The basic operations performed by a computer are 

A) Arithmetic operation 

B) Logical operation 

C) Storage and relative 

D) All the above 

Ans : D ( All the above ) 

 

3. The two major types of computer chips are 

A) External memory chip 

B) Primary memory chip 

C) Microprocessor chip 

D) Both b and c 

Ans : D ( Both b and c ) 

 

4. Microprocessors as switching devices are for which generation computers 

A) First Generation 

B) Second Generation 
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C) Third Generation 

D) Fourth Generation 

Ans : D ( Fourth Generation ) 

5. What does EBCDIC stand for? 

A) Extended Binary Coded Decimal Interchange Code 

B) Extended Bit Code Decimal Interchange Code 

C) Extended Bit Case Decimal Interchange Code 

D) Extended Binary Case Decimal Interchange Code 

Ans : A ( Extended Binary Coded Decimal Interchange Code ) 

 

6. The brain of any computer system is 

A) ALU 

B) Memory 

C) CPU 

D) Control unit 

Ans : C (CPU ) 

 

7. The two kinds of main memory are: 

A) Primary and secondary 

B) Random and sequential 

C) ROM and RAM 

D) All of above 

Ans : C ( ROM and RAM ) 

 

8. Integrated Circuits (ICs) are related to which generation of computers? 

A) First generation 
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B) Second generation 

C) Third generation 

D) Fourth generation 

Ans : C ( Third generation ) 

 

9. Main component of first generation computer was 

A) Transistors 

B) Vacuum Tubes and Valves 

C) Integrated Circuits 

D) None of above 

Ans : B ( Vacuum Tubes and Valves ) 

 

10. The output quality of a printer is measured by 

A) Dot per sq. inch 

B) Dot per inch 

C) Dots printed per unit time 

D) All of the above 

Ans : B ( Dot per inch ) 

 

11. Which of the following storage devices can store maximum amount of data? 

A) Floppy Disk 

B) Hard Disk 

C) Compact Disk 

D) Magneto Optic Disk 

Ans : B ( Hard Disk ) 
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12. A physical connection between the microprocessor memory and other parts of 

the microcomputer is known as 

A) Path 

B) Address bus 

C) Route 

D) All of the above 

Ans : B ( Address bus ) 

13. High density double sided floppy disks data store capacity 

A) 1.40 MB 

B) 1.44 GB 

C) 1.40 GB 

D) 1.44 MB 

Ans : D ( 1.44MB ) 

 

14. Most of the Internal and External parts of the computer connect on the 

Mainboard. What is the name of this board? 

A) Motherboard 

B) Breadboard 

C) Daughter board 

D) Grandmother board 

Ans : A ( Motherboard) 

 

15. Hard disks are the most popular medium for 

A) Direct access 

B) Sequential access 
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C) Both of above 

D) None of above 

Ans : A ( Direct Access) 

 

16. When was vacuum tube invented? 

A) 1900 

B) 1906 

C) 1910 

D) 1880 

Ans : B (1906 ) 

17. When was IC invented? 

A) 1900 

B) 1906 

C) 1910 

D) 1959 

Ans : D (1959 ) 

 

18. The digital computer was developed primarily in 

A) USSR 

B) Japan 

C) USA 

D) UK 

Ans : C ( USA ) 

 

19. What is the responsibility of the logical unit in the CPU of a computer? 

A) To produce result 
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B) To compare numbers 

C) To control flow of information 

D) To do math’s works 

Ans : B ( To compare numbers ) 

 

20. Abacus was the first 

A) electronic computer 

B) mechanical computer 

C) electronic calculator 

D) mechanical calculator 

Ans : D ( mechanical calculator ) 

 

21. Instructions and memory address are represented by in Computer 

A) Character code 

B) Binary codes 

C) Binary word 

D) Parity bit 

Ans : B ( Binary codes ) 

 

22. Which is used for manufacturing chips? 

A) Bus 

B) Control unit 

C) Semiconductors 

D) A and b only 

Ans :  C ( Semiconductor ) 
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23. Which generation of computer is still under development 

A) Fourth Generation 

B) Fifth Generation 

C) Sixth Generation 

D) Seventh Generation 

Ans : B (Fifth Generation)  

 

24. Which was the most popular first generation computer? 

A) IBM 650 

B) IBM 360 

C) IBM 1130 

D) IBM 2700 

Ans : A ( IBM 650) 

 

25. Which is considered a direct entry input device? 

A) Optical scanner 

B) Mouse and digitizer 

C) Light pen 

D) All of the above 

Ans : D ( All of the above) 

 

26. BCD is 

A) Binary Coded Decimal 

B) Bit Coded Decimal 

C) Binary Coded Digit 

D) Bit Coded Digit 
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Ans : A (Binary Coded Decimal) 

 

27. From which generation operating systems were developed? 

A) First 

B) Second 

C) Third 

D) Fourth 

Ans : C ( Third) 

 

28. The difference between memory and storage is that memory is and storage is 

A) Temporary, permanent 

B) Permanent, temporary 

C) Slow, fast 

D) All of above 

Ans : A (Temporary, permanent) 

 

29. When was Pascaline invented? 

A) 1617 

B) 1620 

C) 1642 

D) 1837 

Ans : C ( 1642 ) 

 

30. Which of the following is the first computer to use Stored Program Concept? 

A) UNIVAC 

B) ENIAC 
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C) EDSAC 

D) None of above 

Ans : C (EDSAC ) 

 

31.The term gigabyte refers to 

A) 1024 bytes 

B) 1024 kilobytes 

C) 1024 megabytes 

D) 1024 gigabyte 

Ans : C ( 1024 megabytes ) 

 

32. A byte consists of 

A) One bit 

B) Four bits 

C) Eight bits 

D) Sixteen bits 

Ans : C ( Eight bits) 

 

33. What is the date when Babbage conceived Analytical engine 

A) 1642 

B) 1837 

C) 1880 

D) 1850 

Ans : B ( 1837 ) or may be 1833-34 also. 
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34. Which of the following is not anti-viruses software? 

A) Nortan Antivirus 

B) Quick Heal 

C) Oracle 

D) McAfee 

Ans : C ( Oracle ) 

 

35. What is a compiler? 

A) A compiler does a conversion line by line as the program is run 

B) A compiler converts the whole of a higher level program code into machine code 

in one step 

C) A compiler is a general purpose language providing very efficient execution 

D) None of the above 

Ans : B ( A compiler converts the whole of a higher level program code into machine 

code in one step )  

 

36. computers are also called personal computers 

A) Mainframe Computer 

B) Mini Computers 

C) Micro Computers 

D) Super Computers 

Ans : C ( Micro Computer ) 

 

 

37. Which of the following is not input unit device? 

A) scanner 
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B) camera 

C) plotter 

D) digitizer 

Ans : C ( plotter ) 

 

38. Which one is the largest space? 

A) kilobyte 

B) petabyte 

C) terabyte 

D) gigabyte 

Ans : B ( petabyte ) 

 

39. The brain of any computer system is 

A) Control Unit 

B) Arithmetic Logic Unit 

C) Central Processing Unit 

D) Storage Unit 

Ans : C ( Central Processing Unit ) 

 

40. The BIOS is the abbreviation of . 

A) Basic Input Output System 

B) Best Input Output System 

C) Basic Input Output Symbol 

D) Base Input Output System 

Ans : A ( Basic Input Output System) 
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41. What does DMA stand for? 

A) Distinct Memory Access 

B) Direct Memory Access 

C) Direct Module Access 

D) Direct Memory Allocation 

Ans : B ( Direct Memory Access ) 

 

42. Operating system, editors, and debuggers comes under? 

A) System Software 

B) Application Software 

C) Utilities 

D) None of the above 

Ans : A ( System Software ) 

 

43. Which is the largest computer? 

A) Mainframe Computer 

B) Mini Computers 

C) Micro Computers 

D) Super Computers 

Ans : A ( Mainframe Computer ) 

 

44. The personal computer industry was started by 

A) IBM 

B) Apple 

C) Compaq 

D) HCL 
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Ans : A ( IBM ) 

 

45. Who invented vacuum tubes? 

A) John Bardeen 

B) William Shockley 

C) Lee de Forest 

D) All of above 

Ans : C ( Lee de Forest ) 

 

46. The central processing unit (CPU) consists of 

A) Input, output and processing 

B) Control unit, primary storage, and secondary storage 

C) Control unit, arithmetic-logic unit and primary storage 

D) Control unit, processing, and primary storage 

Ans : C ( Control unit, arithmetic-logic unit and primary storage ) 

 

47. The earliest calculating devices are 

A) Abacus 

B) Clock 

C) Difference Engine 

D) None of these 

Ans : A ( Abacus ) 

 

48. Which unit converts computer data into human readable form? 

A) Input unit 

B) Output unit 
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C) ALU 

D) Control Unit 

Ans : B ( Output unit ) 

 

49. The full form of ALU is 

A) Arithmetic Logic Unit 

B) Array Logic Unit 

C) Application Logic Unit 

D) None of above 

Ans : A ( Arithmetic Logic Unit ) 

 

50. Which of the following device was not invented by Babbage? 

A) Pascaline 

B) Difference Engine 

C) Analytical Engine 

D) None of above 

Ans : A ( Pascaline ) 

 

51. Which number system is usually followed in a typical 32-bit computer? 

A) Binary 

B) Decimal 

C) Hexadecimal 

D) Octal 

Ans : A ( Binary ) 
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52. A paper printout of a document is known as 

A) Softcopy output 

B) Hardcopy output 

C) Permanent Output 

D) All of above 

Ans : B (Hardcopy output) 

 

53. Which electronic component was made out of semiconductor material? 

A) Vacuum tubes 

B) Transistors 

C) ICs 

D) All of above 

Ans : C ( ICs ) 

 

54. Which part of the computer is used for calculating and comparing? 

A) Disk unit 

B) Control unit 

C) ALU 

D) Modem 

Ans : C ( ALU ) 

 

55. The Second Generation Computer was based on . 

A) Vacuum Tube 

B) Silicon Chips 

C) Transistor 

D) Bio Chips 
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Ans : C ( Transistor ) 

 

56. Which of the following programming language started from second generation? 

A) Cobol 

B) BASIC 

C) C 

D) LISP 

Ans : A ( Cobol ) 

 

57. The translator program used in assembly language is called 

A) Compiler 

B) Interpreter 

C) Assembler 

D) Translator 

Ans : C ( Assembler ) 

 

58. EEPROM stands for 

A) Electrically Erasable Programmable Read Only Memory 

B) Easily Erasable Programmable Read Only Memory 

C) Electronic Erasable Programmable Read Only Memory 

D) None of the above 

Ans : A ( Electrically Erasable Programmable Read Only Memory ) 

 

59. First generation computers used for memory 

A) vacuum tubes 

B) silicon chips 
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C) magnetic drum 

D) RAM 

Ans : C ( magnetic drum ) 

 

60. A 32 bit microprocessor has the word length equal to 

A) 2 byte 

B) 32 byte 

C) 4 byte 

D) 8 byte 

Ans : C ( 4 byte ) 

 

61. The term GIGO is related to 

A) Accuracy 

B) Reliability 

C) Versatility 

D) Automatic 

Ans : A ( Accuracy ) 

 

62. Bit stands for 

A) Binary digits 

B) bit of system 

C) a part of byte 

D) All of above 

Ans : A ( Binary digits ) 
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63. Which device can understand difference between data & programs? 

A) Input device 

B) Output device 

C) Memory 

D) Microprocessor 

Ans : D ( Microprocessor ) 

 

64. Which of the following is a read only memory storage device? 

A) Floppy Disk 

B) CD-ROM 

C) Hard Disk 

D) None of these 

Ans : B ( CD-ROM ) 

 

65. After copying the content how many times can you paste? 

A) 1 

B) 16 

C) 32 

D) Many 

Ans : D ( Many ) 

 

66. WAN stands for 

A) Wap Area Network 

B) Wide Area Network 

C) Wide Array Net 

D) Wireless Area Network 
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Ans : B ( Wide Area Network ) 

 

67. An error in computer data is called 

A) Chip 

B) Bug 

C) CPU 

D) Storage device 

Ans : B ( Bug ) 

 

68, nibble equals to 

A) 1 bits 

B) 2 bits 

C) 4 bits 

D) 8 bits 

Ans : C ( 4 bits ) 

 

69. Which unit holds data temporarily? 

A) Input unit 

B) Secondary storage unit 

C) Output Unit 

D) Primary Memory Unit 

Ans : D ( Primary Memory Unit ) 

 

70. The computer size was very large in 

A) First Generation 

B) Second Generation 
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C) Third Generation 

D) Fourth Generation 

Ans : A ( First Generation ) 

 

71. Which of the following is not computer language? 

A) High level language 

B) Medium level language 

C) Low level language 

D) All of the above 

Ans : B ( Medium level language ) 

 

72. The term ‘computer’ is derived from 

A) Greek language 

B) Sanskrit language 

C) Latin language 

D) German language 

Ans : C ( Latin language ) 

 

73. A hard copy would be prepared on a 

A) Line printer 

B) Dot matrix Printer 

C) Typewriter terminal 

D) All of the above 

Ans : D ( All of the above ) 
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74. Hard disk is coated in both sides with 

A) Magnetic metallic oxide 

B) Optical metallic oxide 

C) Carbon layer 

D) All of the above 

Ans : A ( Magnetic metallic oxide ) 

 

75. Which of the following are (is) considered to be video component? 

A) Resolution 

B) Color depth 

C) Refresh rate 

D) All of the alcove 

Ans : D ( All of the alcove ) 

 

76. The programs which are as permanent as hardware and stored in ROM is 

known as 

A) Hardware 

B) Software 

C) Firmware 

D) ROM ware 

Ans : C ( Firmware ) 

 

77. Which of the following memories must be refreshed many times per second? 

A) Static RAM 

B) Dynamic RAM 
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C) EPROM 

D) ROM 

Ans : B ( Dynamic RAM ) 

 

78. Which of the following is the most powerful computers? 

A) Mainframe Computer 

B) Mini Computers 

C) Micro Computers 

D) Super Computers 

Ans : D ( Super Computers ) 

 

79. What is the path from which data flow in a computer system is known as 

A) Car 

B) Bus 

C) Truck 

D) Road 

Ans : B ( Bus) 

 

80. ASCII stands for 

A) American Stable Code for International Interchange 

B) American Standard Case for Institutional Interchange 

C) American Standard Code for Information Interchange 

D) American Standard Code for Interchange Information 

Ans : D ( American Standard Code for Interchange Information) 
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81. From which generation computers the printers were used? 

A) first 

B) second 

C) third 

D) fourth 

Ans : D ( fourth) 

 

82. What is the generation of computers with Micro processor? 

a) First 

b) Second 

c) Third 

d) Fourth 

Ans: D (Fourth) 

 

83. The capacity of a CPU is measured in ______ 

A) DPI 

B) PPI 

C) MIPS 

D) None of these 

Ans: C (MIPS) 

 

84. When did Intel succeed in keeping all the components on a single chip? 

A) 1968 AD 

B) 1970 AD 

C) 1969 AD 
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D) 1971 AD 

Ans: D (1971 AD) 

 

85. Which was the first Micro Processor. 

A) Intel 4004 

B) Intel 4005 

C) Intel 100 

D) Intel 200 

Ans: A (Intel 4004) 

 

 

86. What is the age of the third generation computers. 

A) 1946-58 

B) 1959-64 

C) 1965-70 

D) 1971-85 

Ans: C (1965-70) 

 

87. What is the age of computer of fourth generation computers? 

A) 1946-58 

B) 1959-64 

C) 1965-70 

D) 1971-85 

Ans (D) 1971-85 
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88. Worm is a type of optical memory, its full form. 

(A) Write ones Read Memory 

(B) Write Ones Rugged Memory 

(C) Writet optical read memory 

(D) None of these 

Ans: (A) Write ones Read Memory 

89. What is cache memory? 

(A) Fast memory between C. P.U. and Main Memory 

(B) Slow memory located between CPU and main storage 

(C) Direct memory 

(D) Indirect memory 

Ans: (A)Fast memory between C. P.U. and Main Memory 

 

90. Cache Memory works between the main memory and CPU in which way ? 

(A) Like buffer 

(B) Like Storekeeper 

(C) Like Gunner 

(D) Like Brother 

Ans: (A) Like buffer 

 

91. Which card is used to listen to the computer’s voice or record the voice in the 

computer ? 

A) Sound Card 

B) VGA Card 

C) HGA Card 
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D) None of these 

Ans: (a) Sound Cards 

 

92. What is ‘C’ ? 

A) is a letter 

B) is a design 

C) programming language 

D) None of these 

Ans: (c) Programming Language 

 

93. Which is the Full form of CMOS ? 

A) Central Metal Oven System 

B) Complimentary metal oxide semiconductor 

C) Central Monitor of State 

D) None of these 

Ans: (b) Complimentary Metal Oxide Semiconductor 

 

94. Who made the Apple-I ? 

A) Jean-Amedel 

B) Wright Brothers 

C) Stephen Wajianak and Steven Jabs 

D) None of these 

Ans: (c) Stefan Wajianak and Steven Jobs 

 

95.  What is computer aided design (CAD) 

A) Engineering Drawing Software 



27 
 

B) Fashion Design Software 

C) Ceramic Design Software 

D) None of these 

Ans: (a) Engineer Drawing Software 

 

96. And, OR and NOT are used under the operator? 

A) Semantic Gate 

B) Relational Gate 

C) Logical Gate 

D) Functional Gate 

Ans: – (C) Logical Gate 
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Internet & Basic Networking 

 

1. “www” stands for 

A. World Wide War 

B. World Wide Wait 

C. World Wide Wares 

D. World Wide Web 

Correct Answer – D 

2. Google (www.google.com) is a 

A. Chat service on the web 

B. Directory of images 

C. Search Engine 

D. Number in Math 

Correct Answer – C 

3. ISP stands for 

A. Internet Survey Period 

B. Internet Service Provider 

C. Integrated Service Provider 

D. Internet Security Protocol 

Correct Answer – B 

4. A domain name ending with “org” is 

A. A site which has very high traffic 

B. A network site 

C. A commercial website 

D. An organization 

Correct Answer – D 

5. Internet Explorer, Google Chrome, Firefox, Opera is a 

A. Any person browsing the net 

B. Web Browser 

C. Graphing Package 

D. News Reader 

Correct Answer – B 

6. Which of the following protocols is used for WWW ? 

A ftp 
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B http 

C w3 

D all of the above 

Correct Answer – B 

 

 

7. The first network that planted the seeds of Internet was: 

A ARPANET 

B NSFnet 

C Vnet 

D Both (A) an 

Correct Answer – A 

8. The equipment needed to allow home computers to connect to the Internet is called a 

A. Modem 

B. Gateway 

C.  Monitor 

D. Peripheral 

Correct Answer – A 

9. The communication protocol used by Internet is: 

A. HTTP 

B. WWW 

C. TCP/IP 

D.  FTP 

Correct Answer – C 

10. LAN stands for 

A. Location access network 

B. Local anti network 

C. Local area network 

D. Location area network 

Correct Answer – C 

11. WAN stands for 

A. Wide area network 

B. World area network 

C. Wonder area network 



30 
 

D. None of these 

Correct Answer – A 

12. Ethernet is family of protocol used in 

A. LAN 

B. MAN 

C. WAN 

D. BIOS 

Correct Answer – A 

 

13. MIME full form 

A. Multipurpose Internet Mail Extension 

B. Multiple Internet Mail Extension 

C. Multipurpose Internal Mail Extension 

D. Multidimensional Internet Mail Extension 

Correct Answer – A 

14. Password is a 

A. Dynamic 

B. Case insensitive 

C. Static 

D. Case sensitive 

Correct Answer – D 

15. Twisted pairs are used in 

A. Organizations 

B. Business purpose 

C. Telecommunications & Networking 

D. None of these 

Correct Answer – C 

16. _______ allow you to communicate with other computers using a phone line. 

A. cable 

B. Internet 

C. Software 

D. Modem 

Correct Answer – D 

17. One can transmit and other can receive is called 

A. Network 
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B. Full duplex 

C. Half duplex 

D. Simplex 

Correct Answer – D 

18. _______ is example of Full duplex 

A. Walkie-talkies 

B. Monitor 

C. Keyboard 

D. Telephone 

Correct Answer – D 

 

 

19. Set of rules that governs data communication is called 

A. Internet 

B. Topology 

C. Protocol 

D. None 

Correct Answer – C 

20. Which of the following protocol is used for e-mail services. 

A) SMAP 

B) SMTP 

C) SMIP 

D) SMOP 

Correct Answer – B 

21. …………………. is the incoming e-mail server. 

A) POP 

B) SMTP 

C) SMIP 

D) PPP 

Correct Answer – A 

22. Which type of network would use phone lines? 

A. MAN 

B.LAN 

C. WAN 

D. Wireless 

Correct Answer – C 
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23. Who is Known as the father of World Wide Web (WWW)? 

A. Robert Cailliau 

B. Tim Thompson 

C. Charles Darwin 

D. Tim Berners-Lee 

Correct Answer – D 

24. Which of the following is not a browser? 

A. Microsofts Bing 

B. Netscape Navigator 

C. Mozilla Firefox 

D. Opera 

Correct Answer – A (It’s a search engine) 

 

 

 

25. What is a FTP program used for? 

A. Transfer & Download /Upload files to and from an Internet Server 

B. Designing a website 

C. Connecting to the internet 

D. None of the above 

Correct Answer – A 

26. What do I need to get into the Internet? 

A. Computer 

B. Modem 

C. Browser 

D. All of the above 

Correct Answer – D 

27. Outlook Express is a _________ 

A. E-Mail Client 

B. Browser 

C. SearchEngine 

D. None of the above 

Correct Answer – A 

28. What does the .com domain represents? 

A. Education domain 



33 
 

B. Commercial domain 

C. Network 

D. None of the above 

Correct Answer – B 

29. What is a search engine? 

A. a program that searches engines 

B. a web site that searches anything 

C. a hardware component 

D. a machinery engine that search data 

Correct Answer – B 

30. What is the full form of TCP/IP? 

A. transmission control protocol / internet protocol 

B. telephone call protocol / international protocol 

C. transport control protocol / internet protocol 

D. none of the above 

Correct Answer – A 

 

31. Voice over IP (Voice over Internet Protocol or “VoIP”) technology converts voice calls 

from 

A. analog to digital 

B. digital to analog 

C. It depends 

D. None of the above 

Correct Answer – A 

32. What is the domain used for non-profitable organizations 

A. gov 

B. org 

C. net 

D. in 

Correct Answer – B 

33 What is the full form of TCP ? 

a) Total call protocol 

b) Transmission control protocol 

c) Transmission call protocol 
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d) Transmission circuit pole 

Correct Ans: b) Transmission control protocol 

34. What is the full form of the IP ? 

a) Indian Protocol 

b) International Protocol 

c) Internet Protocol 

d) Inkjet printers 

Correct Ans: c) Internet Protocol 

 

35. ISP is a short form of what. 

a) Indian Service Point 

b) International Service Point 

c) Internet Service Provider 

d) None of the above 

Correct Ans: c) Internet Service Provider 

 

36. What is the work of ISP. 

a) Registering a Usar 

b) Broadcast 

c) Providing internet links to users 

d) None of the above 

Correct Ans.: c) Providing internet links to users 

37. What is Internet Addresses? 

a) Allocated number of computers to exchange information through TCP/ IP 

b) Software company Address 

c) Internet address 

d) None of the above 

Correct Ans: a) Allocated number of computers to exchange information through TCP/ IP 

 

38. What is Server ? 

a) A special type of service provider computer 

b) The service provider 

c) Both statements are true 

d) Both statements are false 

Correct Ans: a) A special type of service provider computer 
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39. What is the device that convert digital data into analog and analog data into 

digital ? 

a) Modem 

b) We set 

c) Calculator 

d) Router 

Correct Ans.: a) Modem 

40..What is the full form of DNS ? 

a) Domain Name System 

b) Driving Name System 

c) Domain Navigation System 

d) None of these 

Correct Ans: a) Domain Name System 

41. Which indication is used for business organizations in domain names ? 

a) .com 

b) .net 

c) .gov 

d) .org 

Correct Ans: a) .com 

 

 

42. Which sign is used for network organizations in the domain name? 

a) .com 

b) .net 

c) .gov 

d) .edu 

Correct Ans: b) .net 

43. Which sign is used for government organizations in the domain name? 

a) .com 

b) .net 

c) .gov 

d) .edu 

Correct Ans: c) .gov 
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44. Which indication is used for academic institution in domain name ? 

a) .com 

b) .net 

c) .gov 

d) .edu 

Correct Ans: d) .edu 

45. Which signal is used for unclassified military network in the domain name ? 

a) .com 

b) .mil 

c) .gov 

d) .edu 

Correct Ans: b) .mil 

46. In the naming of domains, what are the sign used for those organizations, 

which do not come in the category of business organization 

nor educational institution ? 

a) .com 

b) .org 

c) .gov 

d) .edu 

Correct Ans: b) .org 

 

 

47. What is the indication of the United States under the name of domain names? 

a) .ame 

b) .usa 

c) .us 

d) .america 

Correct Ans: c) .us 

 

48. What is the sign of china under the name of the domain ? 

a) .china 
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b) .chn 

c) .cn 

d) .ci 

Correct Ans: c) .cn 

49. IP address is created by how many sets of digits separated by dot ? 

a) Two 

b) Four 

c) Six 

d) Eight 

Correct Ans: b) Four 

50.  What are the requirements of the user to connect to the Internet ? 

A) Telephone, television, teleprinter 

B) Telephone, Modem, Satellite 

C) Computer, Scanner, Printer 

D) Telephone, Modem, Computer 

Correct Answer: d) Telephone, Modem, Computer 

51.  A software that helps to show the web page on the screen and navigates on the Web, 

what it is called ? 

A) Search Engine 

B) Browser 

C) Explorer 

D) Inventor 

Correct Answer: b) Browser 

52. What is the World Wide Web? 

A) Browsing System 

B) World-class network 

C) Inspector Software 

D) None of these 

Correct Answer: a) Browsing System 

53. What is the complete form of HTML. 

A) Heavy thermal metal line 

B) Hyper Text Markup Language 

C) Hyper Text Markup Line 

D) Hard text markup language 

Correct Answer: b) Hyper Text Markup Language 
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54. What is the full form of the URL ? 

a) Unified Rare line 

b) Uniform Resource Locator 

c) Universal Revolutionary Land 

d) Union Republic of Laos 

Correct Ans: b) Uniform Resource Locator 

55. What is the full form of http ? 

a) Hypertext Transfer Protocol 

b) Hypertext Training Pole 

c) Heavy Tele Text Program 

d) Hyper Teltext promo 

Correct Ans: a) Hypertext Transfer Protocol 

56. What is the Full form of e-mail ? 

a) English mail 

b) Endless mail 

c) Electronic mail 

d) Electric mail 

Correct Ans: c) Electronic mail 

57. What is e-mail ? 

a) A technology to exchange messages through the internet 

b) Printing techniques through computer 

c) A train 

d) None of these 

Correct Ans: a) A technology to exchange messages through-the internet 

58. What is the essential thing for e-mail? 

a) Envelope and Ticket 

b) Computer and Internet connection 

c) Both 

d) None of these 

Correct Ans: b) Computer and Internet connection 

59. What is the mail coming back to the sender ? 

a) Bank mail 

b) Bounced mail 

c) Return mail 
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d) None of these 

Correct Ans: b) Bounced mail 

 

60. What is the message sent through e-mails by commercial companies ? 

a) Junk mail 

b) Rough Match 

c) Bounced mail 

d) Frontier mail 

Correct Ans: a) Junk mail 

 

61. What is the full form of FTP ? 

a) Foreign Transfer Program 

b) Founder Transfer Protocol 

c) File Transfer Protocol 

d) None of these 

Correct Ans: c) File Transfer Protoco 

62. FTP work in two modes to show their names — 

a) Upload and Download 

b) Direct and Indirect 

c) Transfer and Postings 

d) None of these 

Correct Ans: a) Upload and Download 

63. Where did the internet start ? 

a) India 

b) Sudan 

c) United states 

d) Brazil 

Correct Ans: c) United states 

64. Name of computer network limited to any college campus. 

A) Internet 

B) Wide Area Network 

C) Campus Area Network 

D) Ectranet 

Answer- (c) Campus Area Network 
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65. Which of the following is a small single site network? 

A) LAN 

B) DSL 

C) RAM 

D) None of these 

Answer- (a) LAN 

 

 

66. The page that is first displayed when accessing a website is called. 

A) First page 

B) Main page 

C) Home page 

D) None of these 

Answer- (c) Home page 

 

67. The standard protocol used on the Internet. 

A) HTML 

B) HTTP 

C) TCP / IP 

D) JAVA 

Answer- (c) TCP / IP 

68. The complete form of HTML is 

A) High Transfer Markup Language 

B) Hyper Text Markup Language 

C) High Text Machine 

D) None of these 

Answer- (b) Hyper Text Markup Language 

 

69. In URl http: // www http is ………… 

A) Host 

B) Domain names 

C) Protocol 

D) Domain address 

Answer- (c) Protocol 
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70. The main work of the firewall is. 

A) Monitoring and filtering 

B) Deleting 

C) Moving 

D) None of these 

Answer- (a) Monitoring and filtering 

71. Proxy server is used. 

A) To provide protection against unauthorized users 

B) Access to Database 

C) To give TCP / IP 

D) None of these 

Answer- (a) To provide protection against unauthorized users 

 

72. This virus often comes from the floppy disk left in the floppy disk drive. 

A) Trajan horse 

B) Boot Sector Virus 

C) Script 

D) Logic Bomb 

Answer- (b) Boot Sector Virus 

 

73. A program that has the ability to infect other programs and which can spread itself to 

other programs by making own copies. 

A) Warm 

B) Virus 

C) Transaction 

D) None of these 

Answer- (b) Virus 

 

 

74. Computer hacker is 

A) A person who maintains computer security 

B) A person who does not comply with computer security with malicious intent of personal 

gain 
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C) A person who is responsible for the safe operation of the computer 

D) None of these 

Answer- (b) A person who does not comply with computer protection from malicious intent 

of personal gain 

 

75. Junk e-mail is called . 

A) Scrap 

B) spoof 

C) Script 

D) Spam 

Answer- (d) spam 

 

76. If your computer automatically reboots then it is likely that in this case- 

A) is a virus 

B) Memory is not enough 

C) Not printed 

D) None of these 

Answer- (a) is a virus 

77. What is CC? 

A) Computer language 

B) Business language 

C) Agricultural Code 

D) Send mail to more than one person 

Answer- (d) sending mail to more than one person 

78 The e-mail attached is. 

A) Receipt sent by recipient 

B) A document from another program which has been sent by linking to e-mail. 

C) List of recipients 

D) None of these 

Answer- (b) A document from another program which has been sent by linking to e-

mail. 

79. Video conferencing is. 

A) Operation of video call by utilizing telecommunication technology 

B) Operation of call on telephone 
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C) Both 

D) None of these 

Answer- (a) Operation of video call by utilizing telecommunication technology 

 

MS-OFFICE QUESTIONS MCQs 

 

1. Which of these is not the right version of MS-OFFICE. 

A) OFFICE XP 

B) OFFICE VISTA 

C) OFFICE 2007 

D) OFFICE 2010 

Correct Answer : B 

2. End key …………………………… 

A) Moves the cursor end of the line 

B) Moves the cursor end of the document 

C) Moves the cursor end of the paragraph 

D) Moves the cursor end of the screen 

Correct Answer : A 

3.MS-Office is- 

A) Application Software 

B) System Software 

C) Operating System 

D) All of Above 

Correct Answer : A 

4.In which layout, the margin of the page is displayed in MS Word – 

A) Outline layout 

B) Web layout 

C) Normal layout 

D) Print layout 

Correct Answer : D 
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5. Which of the following is not a office suite? 

A) MS-Office 

B) Lotus Office 

C) Star Office 

D) Close Office 

Correct Answer : D 

6. The formatting toolbar has the Minimum and Maximum Size of the font.- 

A) 8, 68 

B) 8, 70 

C) 6, 68 

D) 8,72 

Correct Answer : D 

7. In a paragraph, the distance between the two rows is called ………………. 

A) Spacing 

B) Word Spacing 

C) Line Spacing 

D) Row Spacing 

Correct Answer : C 

 

 

8. Usually in a rows, line spacing is – 

A) 1.5 

B) 2.0 

C) 0.5 

D) 1.0 

Correct Answer : D 

9. An extension of the file created in MS-Word 2003. 

A) .doc 

B) .docx 

C) .ppt 
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D) .exe 

Correct Answer : A 

10. Which of the following menu is used in MS-Word to change the character 

size and typeface? 

A) View 

B) Tools 

C) Format 

D) Data 

Correct Answer : C 

11. In the .__________, the first letter of each word comes in a small case and 

all other letters come in a big case. 

A) Uppercase 

B) Lowercase 

C) Toggle case 

D) Title case 

Correct Answer : C 

12. By default, _____________ header or footer printed 

A) On first page 

B) On every page 

C) on Last page 

D) None Of Above 

Correct Answer : B 

13.How many maximum lines can be set for the drop cap ? 

A) 15 

B) 20 

C) 10 

D) Undefined 

Correct Answer : C 

14.Which of the following options is  in  Slide Templates 

A) Graphics, text, styles, macros 

B) Customized word command setting 

C) Auto text entries 
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D) All of above 

Correct Answer : D) All of above 

 

15. Why drop cap is used in the document 

A) To drop all the capital letters 

B) Every paragraph starts automatically with the capital letters 

C) Beginning the paragraph with a large capital letter 

D) None of these 

Correct Answer : C 

16. Which of the following is not a font style? 

A) Bold 

B) Italic 

C) Regular 

D) Superscript 

Correct Answer : D 

17. Which of the following options is not in the Insert – Picture menu? 

A) Chart 

B) Graph 

C) Clip Art 

D) Word Art 

Correct Answer : B 

18. Which of these commands is not available in the Tools menu 

A) Auto summarize 

B) Auto text 

C) Macro 

D) Autocorrect 

Correct Answer : B 

19. Superscript, subscript, outline, emboss, engrave are known as- 

A) Font effects 

B) Text effects 

C) Font styles 
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D) Word Art 

Correct Answer : A 

20. The name of the font used by default in MS-Word.  

A) Times New Roman 

B) Algerian 

C) Arial 

D) None of These 

Correct Answer : A 

21. In which toolbar you can get the Format painter tool. 

A) Picture toolbar 

B) Formatting toolbar 

C) Drawing toolbar 

D) Standard toolbar 

Correct Answer : D 

 

 

22. We can search ____________ by using the Find option. 

A) Characters 

B) Formats 

C) Symbols 

D) All of These 

Correct Answer : D 

23. What is MS-Word? 

A) Operating System 

B) Typing Tutor Software 

C) Word Processing Software 

D) A Game 

Correct Answer : C 

24. What is the Shortcut-Key , to open ‘Open Dialog Box’ 

A) F12 

B) Shift + F12 
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C) Alt + F12 

D) Ctrl + F12 

Correct Answer : D 

25. The effect shown in the Background Color or Document does not appear 

in the _________ 

A) Print Preview 

B) Print Layout View 

C) Reading View 

D) Web Page Layout 

Correct Answer : A 

26. Which of these options is not correct? 

A) Title Bar 

B) Status Bar 

C) Properties Bar 

D) Down Bar 

Correct Answer : D 

27. Which of the following options is not in the Window menu ? 

A) New window 

B) Help 

C) Arrange All 

D) Split 

Correct Answer : B 

28. Insert Date, Format Page Number, and Insert Auto text is the buttons of 

_________ toolbar 

A) Formatting 

B) Header and Footer 

C) Standard 

D) Edit 

Correct Answer : B 
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29. Page Border option is in the _________ menu. 

A) Insert 

B) Format 

C) Tools 

D) View 

Correct Answer : B 

30. Copied Data in MS-Word is shown in ……………. 

A) Task bar 

B) Task pane 

C) Clip art 

D) None of these 

Correct Answer : D 

31. How many steps are there in Mail merger 

A) 5 

B) 6 

C) 7 

D) 8 

Correct Answer :  B 

32. Which menu contains the option of Bullets and Numbering 

A) Insert 

B) Format 

C) Tools 

D) View 

Correct Answer :  B 

33. What is the shortcut key to break the line. 

A) CTRL + Enter 

B) Alt + Enter 

C) Shift + Enter 

D) Space + Enter 

Correct Answer : C 

34. How many types of summaries can we create in “Auto Summarize option” 

in MS Word  
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A) 3 

B) 4 

C) 5 

D) 6 

Correct Answer :  B 

35. The maximum number of characters in the file name created in MS 

Windows can be 

A) 256 

B) 255 

C) 8 

D) 11 

Correct Answer : B 

 

 

36. With the help of which of these toolbar we can change the font size and 

color 

A) Standard 

B) Formatting 

C) Print Preview 

D) None of these 

Correct Answer : B 

37. Gutter’s position can be – 

A) Left & Right 

B) Left & Top 

C) Left & Bottom 

D) Left Only 

Correct Answer : B 

38. What is the default margin on the left of the document page in Word 

2003 

A) 1″ 

B) 1.25″ 
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C) 1.5″ 

D) 2″ 

Correct Answer : B 

39. Which of the following is not a toolbar 

A) Word count Toolbar 

B) Table and Border Toolbar 

C) Reviewing Toolbar 

D) Document Map Toolbar 

Correct Answer : D 

40. What is the shortcut key to change the case of a text 

A) Shift + F3 

B) Ctrl + F5 

C) Shift + C 

D) Ctrl + K 

Correct Answer : A 

41. What is the shortcut key to making a Character superscript 

A) Ctrl + Shift + = 

B) Ctrl + Shift +} 

C) Ctrl + Shift + + 

D) Ctrl + { 

Correct Answer : C 

42. How many ways can we save a document in MS Word 

A) 3 

B) 4 

C) 5 

D) 6 

Correct Answer : A 

 

 

43. Which of these features is used to paste text without formatting it? 

A) Paste Special 
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B) Format Painter 

C) Page Setup 

D) Clear Formatting 

Correct Answer : A 

44. What is the shortcut key to open Thesaurus Window 

A) Ctrl + F7 

B) F7 

C) Shift + F7 

D) Alt + F7 

Correct Answer : C 

45. Which of these options is used to send a similar Letter to different people 

A) macros 

B) template 

C) mail merge 

D) Auto Send 

Correct Answer : C 

46. In the Ms Word 2007, Document File Extension is _________ 

A) WPF 

B) TXT 

C) DOC 

D) DOCX 

Correct Answer : D 

47. In which view of MS Word, the background color and effects are shown 

A) Web layout view 

B) Print Layout view 

C) Reading View 

D) Print Preview 

Correct Answer : B 

48. F12 Key is used for_________ 

A) Save As dialog box 

B) Spelling & Grammar dialog box 

C) Chart Wizard 
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D) Font dialog box 

Correct Answer : A 

49. What is Portrait and Landscape 

A) Page Orientation 

B) Paper Size 

C) Page Layout 

D) Page Margin 

Correct Answer : A 

 

 

50. What is the Short Cut Key for Checking Spell 

A) F1 

B) F2 

C) F7 

D) F9 

Correct Answer : C 

51. Which of these options is used to move text 

A) Copy and Paste 

B) Cut and Paste 

C) Paste and Delete 

D) Paste and Cut 

Correct Answer : B 

52. Which option is used to replace the already saved document’s location 

A) Save as 

B) save 

C) Open 

D) Permission 

Correct Answer : A 

53. Ctrl + E is used for 

A) Re-Open the last closed document 

B) Insert Hyperlink 
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C) Insert Bullets & Numbering 

D) Center align the selected Paragraph 

Correct Answer : D 

54. How to use the Format Painter tool more than once. 

A) Click on Lock Format Painter Icon 

B) Double Click on Format Painter Icon 

C) Selecting Edit – Format Painter – multiple use 

D) Can not use the Format Painter tool more than once. 

Correct Answer : B 

 

55. Which of the following option is used to change the margin 

A) Formatting toolbar 

B) Page setup dialog box 

C) Standard toolbar 

D) Header & Footer dialog box 

Correct Answer : B 

56. Which page size is set by default in Ms word 

A) Letter 

B) Legal 

C) A4 

D) A3 

Correct Answer : A 

 

57. which of the following View, Header and Footer are appeared 

A) Normal View 

B) Page Layout View 

C) Print Layout View 

D) Draft View 

Correct Answer : C 

58. With the help of which of these options spelling mistakes are corrected 

A) Auto Format 
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B) Auto Text 

C) Auto Correct 

D) Auto Spell 

Correct Answer : C 

59. Which menu is used to insert the chart option in MS Word 

A) Edit 

B) Insert 

C) Format 

D) Tools 

Correct Answer : B 

60. __________ is inserted at the end of the document 

A) Footer 

B) Foot Note 

C) End Note 

D) Header 

Correct Answer : A 

61. Maximum Font Size in the Formatting Toolbar – 

A) 72 

B) 82 

C) 48 

D) 92 

Correct Answer : A 

62. How many text alignments are in MS Word 

A) 2 

B) 3 

C) 4 

D) 5 

Correct Answer : C 

63. Which of these options is displayed at Bottom in every page 

A) Header 

B) Foot Note 

C) Title 
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D) Footer 

Correct Answer : D 

 

 

64. Minimum Font Size in the Formatting Toolbar – 

A) 4 

B) 6 

C) 8 

D) 10 

Correct Answer : C 

65. Which key is used to delete the Character from the right side of the 

cursor 

A) Back space 

B) Delete 

C) Shift 

D) Delete +Enter 

Correct Answer : B 

66. Bullets and Numbering tools are used for 

A) To create a list 

B) To provide page numbers 

C) To drawing 

D) All of these 

Correct Answer : A 

67. In word Processing, the best option to shift third paragraph after the fifth 

paragraph 

A) Cut and Paste 

B) Copy and Paste 

C) Delete and Copy 

D) Edit and Paste 

Correct Answer : A 
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68. Which program is used to correct spelling in Ms Word. 

A) Spellpro 

B) Spell Check 

C) Outlook Express 

D) All of these 

Correct Answer : B 

69. Which is not related to text formatting 

A) Line spacing 

B) Text Spacing 

C) Margin change 

D) Searching 

Correct Answer : D 

70. Which menu is selected to cut, copy, and paste. 

A) File 

B) Tools 

C) Edit 

D) Special 

Correct Answer : C 

 

 

71. What is the name given to a Document by the user? 

A) File Name 

B) Program 

C) Record 

D) Data 

Correct Answer : A 

72. Which executable files are used to start MS Word? 

A) Word.exe 

B) Winword.exe 

C) MSword.exe 



58 
 

D) None of the above 

Correct Answer : B 

73. What is the use of thesaurus tool in MS-Word? 

A) Synonyms and Antonyms words 

B) Grammar options 

C) Spelling suggestions 

D) All of the above 

Correct Answer : A 

74. In which of the following menu is used in making columns. 

A) Format 

B) Insert 

C) View 

D) Tools 

Correct Answer : A 

75. In the Ms Word, which key is pressed with the mouse to select a 

sentence. 

A) Shift 

B) Ctrl 

C) Alt 

D) Space 

Correct Answer : B 

76. In MS Excel, in which bar have the currency option 

A) Formatting Toolbar 

B) Standard Toolbar 

C) Status Bar 

D) Formula bar 

Correct answer : A 

77. Which menu contains macro options in MS Excel 

A) Insert 

B) Format 

C) Tools 
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D) Data 

Correct answer : C 

 

 

78. Which function is used to input the date only in MS Excel? 

A) Today 

B) Now 

C) Time 

D) Calendar 

Correct answer : A 

 

79. Which Function is used to calculate Remainder in MS Excel? 

A) INT ( ) 

B) FACT ( ) 

C) MOD ( ) 

D) DIV ( ) 

Correct answer : C 

80. Which menu have the Fill option in MS Excel? 

A) View 

B) Format 

C) Tools 

D) Edit 

Correct answer : D 

81. Excel is a collection of workbook …………. 

A) Workbooks 

B) Worksheets 

C) Charts and Slides 

D) Data 

Correct answer : B 
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82. Which of these data types is not in MS.excel? 

A) Number 

B) Currency 

C) Label 

D) Date/Time 

Correct answer : C 

83. In MS Excel, which menu does have Sort option 

A) Edit 

B) Format 

C) Tool 

D) Data 

Correct answer : D 

84..Which of these charts does not exist in MS Excel 

A) Scatter 

B) Line 

C) Doughnut 

D) Graph 

Correct answer : D 

86. Which of these options is not available in the Chart Options in MS Excel 

“CHART WIZARD”? 

A) Axes 

B) Data Label 

C) Data Series 

D) Data Table 

Correct answer : C 

87. MS EXCEL Based on _______ Software 

A) WINDOWS 

B) DOS 

C) UNIX 

D) LINUX 

Correct answer : A 
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88. A spreadsheet is a collection of pages is called a _______ 

A) Workbook 

B) Art book 

C) Worksheet 

D) Documents 

Correct answer : A 

89. What is the Extension of Excel Workbook in MS Excel 2007? 

A) .xlx 

B) .xlsx 

C) .xlcx 

D) .xlxx 

Correct answer : B 

 

90. Which option of Chart Wizard contains the option of Series Name, 

Category and Value in Data? 

A) Legend 

B) Chart area 

C) Data label 

D) Data Titles 

Correct answer : C 

91. Which sign display when Formula Error in MS Excel 

A) $ 

B) * 

C) \ 

D) # 

Correct answer : D 

92. Which option is not in the Data Menu in MS Excel ? 

A) Validation 

B) Filter 

C) Freeze Pane 
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D) Sort 

Correct answer : C 

93. When using the Function, which reference operator is used to 

give the range? 

A) ; 

B) & 

C): 

D) = 

Correct answer : C 

94. What is the feature of inserting cells by dragging numbers in 

MS Excel ? 

A) Auto Correct 

B) Auto Text 

C) Auto Fill 

D) Auto Cell 

Correct answer : C 

 

95. Which of the options is in the Tool Menu in MS.Excel ? 

A) Formula Auditing 

B) Goal Seek 

C) Scenarios 

D) All of these 

Correct answer : D 

96. Which function is used to calculate Rate of Return, Loan, 

Amount and Future Value ? 

A) Statistical function 

B) Financial function 

C) Logical function 



63 
 

D) Mathematical function 

Correct answer : B 

97. What is the shortcut key to insert current date in cell ? 

A) Ctrl +; 

B) Ctrl + T 

C) Ctrl + D 

D) Ctrl + / 

Correct answer : A 

98. In M.S. Excel if Day Formula is imposed, answer to 5/3/2017 will 

be printed ______ 

A) 5 

B) 3 

C) 2017 

D) 5 mar 

Correct answer : B 

99. Which symbol do you use to start formula in MS Excel? 

A) % 

B) = 

C) + 

D) <> 

Correct answer : B 

100. Which of these functions is used to remove more than one 

space? 

A) Trim 

B) Char 

C) Len 

D) Int 

Correct answer : A 
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101. In MS Excel cell, values 29, 19, 27, 39 and 20 are written from 

A6 to A11. Then what will be the value of = MAX (A6: A11)? 

A) 29 

B) 39 

C) 21 

D) 20 

Correct answer : B 

102. Which chart would be useful to compare the sales price of 

two different branches of a distributor? 

A) Scatter Chart 

B) Bar Chart 

C) Doughnut Chart 

D) Area Chart 

Correct answer : C 

103. Which of these statements is correct? 

A) = POWER(2*3) 

B) = POWER(2^3) 

C) = POWER(2,3) 

D) = POWER(2:3) 

Correct answer : C 

104. Which of these is not an operator in MS Excel? 

A) Text Concatenation Operator 

B) Reference Operator 

C) Arithmetic Operator 

D) Logical Operator 

Correct answer : D 
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105. Where does the active cell’s contents display in Excel? 

A) Name Box 

B) Row Headings 

C) Formula Bar 

D) Task Pane 

Correct answer : C 

 

106. How many steps are there to create charts in MS Excel? 

A) 2 

B) 3 

C) 4 

D) 5 

Correct answer : C 

107. A function does have inside the function is called______ 

A) Nested Function 

B) Round Function 

C) Sum Function 

D) Text Function 

Correct answer : A 

108. The cell address in the Microsoft Office Excel document is 

_________ 

A) Column Name 

B) Row Name 

C) First Row then Column Name 

D) First Column then Row Name 

Correct answer : D 

109. If you want a blank line after the title in the worksheet, which 

of these methods will be the best? 
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A) Re-Format the spreadsheet 

B) Insert the Row 

C) Increase the column Width 

D) Use the Space bar 

Correct answer : B 

 

110. How is the data organize in the spreadsheet? 

A) Line and Spacing 

B) Rows and Columns 

C) Layers and Pallets 

D) Height and Width 

Correct answer : B 

111. In MS Excel, which of the following option is not available in 

the Data menu? 

A) Validation 

B) Filter 

C) Freeze Pane 

D) Sort 

Correct answer : C 

112. “Comment” option is found in the ………… menu. 

A) insert 

B) Data 

C) review 

D) View 

Correct answer : A 

113. What is the shortcut key to insert a new sheet in the current 

workbook? 

A) F11 



67 
 

B) Ctrl + F11 

C) Shift + F11 

D) Alt + F11 

Correct answer : C 

114. How can you show or hide the Grid lines in Excel sheet? 

A) Go to Tools – Options – View tab then Mark or unmarked the 

Grid line box 

B) Click on the Grid Line tool in the Forms Toolbar 

C) A and B Both 

D) None of these 

Correct answer : A 

115. The address of the current cell in Excel is displayed in _______ 

A) Formula bar 

B) Status bar 

C) Name Box 

D) Title bar 

Correct answer : C 

 

116. The shortcut key to add Hyperlink in Worksheet is _______ 

A) Alt + K 

B) Ctrl + H 

C) Ctrl + K 

D) Shift + Ctrl + K 

Correct answer : C 

117. Which of these statements is not correct? 

A) You can create graph in Excel sheet. 

B) Excel sheet has an extension .doc 

C) The new workbook is called book 1. 
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D) None of these 

Correct answer : B 

118. The common point of row and column is called 

A) pixel 

B) cell 

C) 0 

D) Track 

Correct answer : B 

119. Who can use a Spreadsheet? 

A) Finance Professionals 

B) Engineers 

C) Stoke Brokers 

D) All of these 

Correct answer : D 

120. To show the range of cells, we use …………. in excel 

A) Semicolon 

B) Comma 

C) Colon 

D) Dot 

Correct answer : C 

 

121. What is the shortcut to open the dialog box of Format cell? 

A) Alt + 1 

B) Ctrl + 1 

C) Ctrl + Shift + 1 

D) None of these 

Correct answer : B 
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122. The programming language in which Excel keeps the macro 

code record. 

A) Java 

B) Visual Basic 

C) Basic 

D) Video Basic 

Correct answer : B 

 

 

 

123. What is the shortcut key to replace in MS-Excel? 

A) Ctrl+R 

B) Ctrl+E 

C) Ctrl+H 

D) Ctrl+L 

Correct answer : C 

124. Which of the following menu is used for Cut, Copy, Paste, 

Delete text in Excel? 

A) Edit menu 

B) File menu 

C) Tool menu 

D) Format menu 

Correct answer : A 

 

125. The default extension of the Excel file is______ 

A) .XLS 
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B) .XLW 

C) .WK1 

D) .123 

Correct answer : A 

126. A worksheet has a header by default- 

A) User Name 

B) Date and time 

C) Sheet tab name 

D) None 

Correct answer : D 

127. The maximum row in a work sheet is- 

A) 256 

B) 1024 

C) 65536 

D) 32000 

Correct answer : C 

128. Cell reference will be from range G2 to M12. 

A) G2=M12 

B) G2;M12 

C) G2:M12 

D) G2,M12 

Correct answer : C 

 

129. Which menu is used to show and hide the Status Bar in Excel 

A) Edit menu 

B) File menu 

C) View menu 
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D) Format menu 

Correct answer : C 

130. The keyboard shortcut is used to create charts in the selected 

range. 

A) F2 

B) F4 

C) F8 

D) F11 

Correct answer : D 

131.  ________ key is used to drag data of range from selected 

worksheet to another worksheet. 

A) Tab 

B) Alt 

C) Shift 

D) Ctrl 

Correct answer : B 

132. Which column will you select to insert a new column between 

Column D and E. 

A) select column E 

B) select column D 

C) select column E , F , G 

D) select column D, E , F 

Correct answer : A 

133. Which of the following is not the Zoom percentage in excel? 

A) 10 

B) 100 

C) 300 
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D) 500 

Correct answer : D 

134. What is the feature of inserting by dragging number in cells in 

MS Excel ? 

A) Auto Correct 

B) Auto Text 

C) Auto Fill 

D) Auto Cell 

Correct answer : C 

 

135. How many columns are there in Excel? 

A) 256 

B) 65536 

C) 216 

D) 220 

Correct answer : A 

 

136. In which menu have Freeze Pane option? 

A) Tools 

B) Data 

C) Window 

D) View 

Correct Answer : C 

137. Which of these is not the view of PowerPoint? 

A) Slide Show view 

B) Slide Sorter view 

C) Normal view 
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D) Outline view 

Correct Answer : D 

138. What is Extension of PowerPoint Presentation? 

A) .POT 

B) .PPT 

C) .PTP 

D) .PPE 

Correct Answer : B 

139. What is the shortcut key to create new files in PowerPoint 

presentation. 

A) Ctrl + N 

B) Ctrl + S 

C) Ctrl + M 

D) Shift + N 

Correct Answer : A 

 

140. To open Power Point from Run Dialog Box, type ________ 

A) PowerPoint 

B) Pwrpoint 

C) Powerpnt 

D) Powerpint 

Correct Answer : C 

 

141. Which program is used to create a presentation 

A) Excel 

B) PowerPoint 

C) Access 
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D) Outlook 

Correct Answer : B 

142. What is the shortcut key to insert a new slide into the current 

presentation. 

A) Ctrl + O 

B) Ctrl + M 

C) Ctrl + N 

D) Ctrl + F 

Correct Answer : B 

143. Which menu does have action button option ? 

A) Tools 

B) Format 

C) Window 

D) Slide Show 

Correct Answer : D 

144. Which option is used to create Speaker Notes in the Power 

Point slide. 

A) Slide Note 

B) Short Notes 

C) Sound Note 

D) Notes View 

Correct Answer : D 

145. Which option is used to change shadow, text color and the 

color of the box in Power Point 

A) Color schemes 

B) Drawing tools 

C) Text tools 



75 
 

D) Background color 

Correct Answer : A 

 

 

 

 

 

 

 

 

146. How you can stop the slide show. 

A) Pressing Delete button. 

B) Pressing Esc button. 

C) Pressing Right arrow. 

D) Pressing Left arrow. 

Correct Answer : B 

147. _______ task pane shows the design that is currently being 

used in the presentation. 

A) slide show 

B) slide style 

C) slide design 

D) slide format 

Correct Answer : C 

148. How to insert a table in a slide. 

A) Table menu & Insert table 

B) Click on the insert table in the content pane of the blank slide. 

C) A and B Both 
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D) The table can not be inserted into a slide. 

Correct Answer : B 

149. What is the use of the “Hide slide” option? 

A) During the presentation, to hide the selected slide. 

B) During editing, to hide the selected slide. 

C) To hide the selected slide during printing. 

D) To hide the selected slide during deleting. 

Correct Answer : A 

150. Handout Master is defined by _________ 

A) Slide formatting 

B) Slide transaction 

C) Layout of handout 

D) Layout of slide 

Correct Answer : C 

 

151. Which of these slides is used as a background. 

A) Gradient 

B) Texture 

C) Picture 

D) All of these 

Correct Answer : D 

 

152. Ctrl + E command is used in the power point – 

A)To make Text in the left 

B) To make Text in the Right 

C) To make Text in the Center 
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D) All of these 

Correct Answer : C 

153. Ellipse Motion is a Predefined …………. 

A) Design Template 

B) Color Scheme 

C) Animation Scheme 

D) None of these 

Correct Answer : C 

154. How many slides can be printed on the same page by using 

the handout. 

A) 1 

B) 6 

C) 9 

D) All of these 

Correct Answer : D 

 

155. Which feature of Power Point will you use to apply the motion 

effect to different slides? 

A) slide transition 

B) slide Design 

C) Animation object 

D) Animation Scheme 

Correct Answer : A 

156. Which option is used to set a custom timing for a slide in 

Presentation. 

A) Slider timings 

B) slide transition 

C) Rehearsal 
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D) Slide Show Setup 

Correct Answer : B 

157. If you want to see only text in the slide, which of the tabs will 

you use. 

A) Task pane 

B) Thumbnails 

C) Outline 

D) Tool bar 

Correct Answer : C 

 

158. If you want to change the order of slides, which view option 

will you use. 

A) Normal View 

B) slide sorter view 

C) Notes page view 

D) Slide show view 

Correct Answer : B 

159. Which menu contains an option like Animation scheme, 

custom animation, slide transition. 

A) insert menu 

B) tools menu 

C) View menu 

D) slide show menu 

Correct Answer : D 

160. Which option is right for inserting a hyperlink in a slide. 

A) Choose Insert & Hyperlink 

B) Press Ctrl + K 

C) Hyperlink can not be inserted into the slide. 
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D) A and B Both 

Correct Answer : D 

 

161. The slide sorter in the power point is in the ________ menu. 

A) Insert 

B) View 

C) File 

D) Edit 

Correct Answer : B 

162. What happens to “apply design templates”? 

A) Changes the contents of the slide 

B) Adds the functionality of the slide. 

C) Change the look of the slide without any changes in the content 

of the slide. 

D) None of these 

Correct Answer : C 

 

 

 

 

 

163. The Pre-defined style that can be used for presentation in 

Power Point is called- 

A) Auto style 

B) Wizard 
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C) Templates 

D) Pre Formatting 

Correct Answer : C 

164. In a presentation, the animation scheme can be applied in 

which slide. 

A) All slides 

B) Selected slide 

C) Current slide 

D) All of these 

Correct Answer : D 

165. Which of these keys will you press to check spelling. 

A) F3 

B) F5 

C) F7 

D) F9 

Correct Answer : C 

166. How many types of layouts are in the power point 

A) 4 

B) 5 

C) 6 

D)None of these 

Correct Answer : A 

167. What is the command to recolor a picture in a slide? 

A) Insert – Picture – Recolor 

B) Tools – Picture – Recolor 

C) Format – Picture – Recolor 

D) Edit – Picture – Recolor 

Correct Answer : A 
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168. Which of the following option can have in a slide? 

A) Title, Text, graphs 

B) Drawn Object Shapes 

C) Clipart, Drawn art, Visual 

D) Any of these 

Correct Answer : D 

 

 

169. What is animation? 

A) To make a picture 

B) Accelerate static images 

C) Print out 

D) Changing the pictures in the graph 

Correct Answer : B 

 

170. What is the Shortcut Key to Slide Show ? 

A) F4 

B) F5 

C) F6 

D) F7 

Correct Answer : B 

171. Which orientation is set in the default page setup in the 

power point. 

A) Landscape 

B) Portrait 

C) Vertical 
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D) None of these 

Correct Answer : A 

172. Which feature would you use to apply motion effect for slide 

Exit and Enter? 

A) Animation Scheme 

B) Slide Design 

C) Animation Objects 

D) Slide Transition 

Correct Answer : D 

173. Which file formats can add to power point shows? 

A) WAV 

B) JPG 

C) MPEG 

D) All of these 

Correct Answer : D 

 

 

 

174. Which tab does not have on the left panel when you open the 

presentation? 

A) Notes 

B) Outline 

C) Slides 

D) All are available 

Correct Answer : A 
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175. Which section does not exist in slide layout 

A) Animations 

B) Lists 

C) Titles 

D) Charts 

Correct Answer : A 

176. Which Power Point feature would you use to apply the motion 

effect for different objects on the slide? 

A) Animation Scheme 

B) Animation Objects 

C) Slide Design 

D) Slide Transition 

Correct Answer : A 

177. Which of the following is the action button in the power point 

A) Home 

B) Help 

C) End 

D) All of these 

Correct Answer : D 

178. Which option is used to rehearse the presentation in the 

power point 

A) Setup time 

B) Timing 

C) Rehearse Timing 

D) All of these 

Correct Answer : C 

179. Shortcut key to open pre-made Presentation 

A) CTRL + A 
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B) CTRL + O 

C) CTRL + N 

D) CTRL + L 

Correct Answer : B 

 

 

180. Which of these options is used to make a similar type of 

formatting in every slide in PowerPoint. 

A) Slide Transition 

B) Slide Design 

C) Slide Master 

D) All of these 

Correct Answer : C 

181. How to Stop the Slide Show in PowerPoint 

A) Press the right arrow 

B) Press Escape 

C) Press Ctrl + A 

D) Press Ctrl + S 

Correct Answer : B 

182. The page to create Presentation in Power Point is called _____. 

A) Sheet 

B) Paper 

C) Slide 

D) Document 

Correct Answer : C 

183. How the chart is inserted in PowerPoint ? 

A) Edit -> Chart 
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B) Insert -> Pictures -> Chart 

C) Insert -> Chart 

D) View -> Chart 

Correct Answer : C 

184. Which option is used to replace the font in all the slides in 

PowerPoint 

A) Tools -> Fonts 

B) Edit -> Fonts 

C) Format -> Replace Fonts 

D) Tools -> Replace Fonts 

Correct Answer : C 

185. From which of these views can we see all the slides together ? 

A) Through slide sorter view 

B) Through slide view 

C) Through normal view 

D) through slide show 

Correct Answer : A 

 

 

186. Which toolbar has a slide design option in MS Power point ? 

A) Standard Toolbar 

B) Formatting Toolbar 

C) Drawing Toolbar 

D) None of these 

Correct Answer : B 

187. An entire path name, consisting of several sub-directory 

names can contain upto 
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a. 13 character 

b. 36 character 

c. 63 character 

d. 53 character 

Correct Answer: c 

   

188. In which year the first operating system was developed 

a. 1910 

b. 1940 

c. 1950 

d. 1980 

Correct Answer: c 

  

189. MS-DOS developed in 

a. 1991 

b. 1984 

c. 1971 

d. 1961 

Correct Answer: b 
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190. Maximum length of DOS command using any optional 

parameter is 

a. 26 characters 

b. 87 characters 

c. 127 characters 

d. None of above 

Correct Answer: c 

  

 

191. In which version of DOS. CHKDSK command has been 

changed to SCANDISK? 

a. 5.0 

b. 6.2 

c. 6.0 

d. 6.2 

Correct Answer: d 

 

192. CHKDSK command is used to 
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a. Analyze the hard disk error 

b. Diagnose the hard disk error 

c. Report the status of files on disk 

d. All of the above 

Correct Answer: d 

  

 

 

193. Which file is the batch file that is read while booting a 

computer? 

a. Autoexec.bat 

b. Auto-batch 

c. Autoexecutive.bat 

d. Auto.bat 

Correct Answer: a 

 

 

194. Which command is used to backup in DOS 6+ Version 

a. BACKUP 
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b. MSBACKUP 

c. MSBACKEDUP 

d. All of the above 

Correct Answer: b 

 

195. Copy and Xcopy are same in the sense 

a. Both are internal command of DOS 

b. Both are external commands of DOS 

c. Both can be used to copy file or group of files 

d. Both a and b 

Correct Answer: c 

  

  

 

 

196. Which command be used to clear the screen and display the 

operating system prompt on the first line of the display? 

a. Cd 

b. Md 
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c. Rename 

d. cls 

Correct Answer: d 

  

  

197. Which command is used to clear the screen 

a. Cls 

b. Clear 

c. Clscreen 

d. All of above 

Correct Answer: a 

  

  

198. internal command in Dos are 

a. Cls, rd label 

b. Dir, ren, sys 

c. Time, type, dir 

d. Del, disk copy, label 

Correct Answer: c 
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199. Which command is used to copy files? 

a. Copy 

b. Diskcopy 

c. Type 

d. All of the above 

Correct Answer: a 

  

  

200. To copy the hidden system files of DOS to another disk you 

can use the command 

a. Copy 

b. Ren 

c. Sys 

d. Diskcopy 

Correct Answer: c 

  



92 
 

  

 

 

201. Disk copy command in DOS is used to 

a. Copy a file 

202. Copy contents of one floppy disk to another 

c. Copy contents of CD-ROM to another 

d. All of the above 

Correct Answer: b 

  

  

203. SYS command is used to 

a. Copy DOS system files to new disk 

b. Copy DOS configuration files to a new disk 

c. Update the DOS system files 

d. None of above 

Correct Answer: a 
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204. The command used to copy a file named temp.doc from drive 

C: to drive A: is 

a. Copy temp.doc to a: 

b. Copy c:\temp.doc a: 

c. Copy c: a: 

d. Copy temp a: c: 

Correct Answer: b 

  

205. External command in DOS are 

a. Copy, edit, sys, format 

b. Edit, sys, chkdsk 

c. Chkdsk, prompt, date 

d. Sys, ver, vol 

Correct Answer: b 

  

  

 

206. Which keys can be pressed quit without saving in DOS 

a. Ctrl + A 
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b. Ctrl + B 

c. Ctrl + C 

d. Ctrl + D 

Correct Answer: c 

  

  

207. Which command is used to get the current date only? 

a. Date 

b. Time 

c. Second 

d. All of the above 

Correct Answer: a 

  

  

208. Generally, the DATE is entered in the form 

a. DD-YY-MM 

b. YY-DD-MM 

c. MM-YY-DD 

d. MM-DD-YY 
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Correct Answer: d  

  

  

 

209. DEL command is used to 

a. Delete files 

b. Delete directory 

c. Delete labels 

d. Delete contents of file 

Correct Answer: a 

  

  

210. Which command be used to ask you to confirm that you want 

to delete the directory? 

a. Deltree 

b. Deltree/f 

c. Del *.*/p 

d. Erase *.* 

Correct Answer: c 
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211. Which statement is correct? 

a. Directories can be kept inside a file 

b. Files can not be kept inside a directory 

c. 1 millisec = 10 ^ 3 sec 

d. None of above 

Correct Answer: c 

  

  

212. CHKDSK can be used to find 

a. Disk’s bad portion 

b. Occupied space 

c. Free space 

d. All of above 

Correct Answer: d 
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214. DIR command is used to 

a. Display a list of files in a directory 

b. Display contents of files in directory 

c. Display type of files in a sub directory 

d. All of above 

Correct Answer: a 

  

  

 

215. The deleted file in MS-DOS can be recovered if you use the 

command mention below immediately, the command is: 

a. DO NOT DELETE 

b. NO DELETE 

c. UNDELETE 

d. ONDELETE 

Correct Answer: c 

  

  

216 To copy the file command.com from drive c: to drive a: 
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a. Drive c: copy drive a:\command.com 

b. C:A: copy command.com 

c. Copy c:\command.com a: 

d. Both b and c 

Correct Answer: c 

  

  

217. While working with MS-DOS which key is used to get the 

p[revious command used: 

a. F3 

b. F1 

c. F6 

d. F9 

Correct Answer: a 

 

218. FAT stands for 

a. File Accomodation Table 

b. File Access Tape 

c. File Allocation Table 
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d. File Activity Table 

Correct Answer: c 

 

 

 

  

219. xcopy command can copy 

a. individual files or group of files 

b. directories including subdirectories 

c. to diskette of a different capacity 

d. all of above 

Correct Answer: d 

  

  

220. Which command is used to make a new directory? 

a. Md 

b. Cd 

c. Rd 

d. None of above 
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Correct Answer: a 

  

221. Full form of MS-DOS is 

a. Micro System Disk Operating System 

b. Micro Simple Disk Operating System 

c. Micro Soft Disk Operating System 

d. Micro Sort Disk Operating System 

Correct Answer: c 

 

222. Operating System is like a 

a. Parliament 

b. Secretary 

c. Government 

d. None of the above 

Correct Answer: c 

223. Format command is used to 

a. Prepare a blank disk 

b. Create a new blank disk from a used one 

c. Both of above 
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d. None of above 

Correct Answer: c 

  

  

224. The following command set is correct according to their 

function 

a. RD can MD 

b. DEL and ERASE 

c. CD and RD 

d. COPY and RENAME 

Correct Answer: b 

  

  

225. Which command is used to change the file name? 

a. Ren 

b. Rename 

c. Both of above 

d. None of above 

Correct Answer: c 
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226. While working with MS-DOS, which command is used to 

copying the files to transfer from one PC to another one? 

a. Rename 

b. Path 

c. Dir 

d. Copy 

Correct Answer: d 

  

227. RESTORE command is used to 

a. Restore files from disks made using the BACKUP command 

b. Restore files which are deleted 

c. Restore files from recycle bin 

d. Restore files which are deleted recently 

Correct Answer: a 
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228. The vol command is used to 

a. see the value of list 

b. see the veriety of language 

c. see the disk volume label 

d. see the volume of largest 

Correct Answer: c 

  

  

229. In MS-DOS you can use small or capital letter of combination 

of both to enter a command but internally MS-DOS work with. 

a. Small letter 

b. Capital letter 

c. Both a and b 

d. None of above 

Correct Answer: b 
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230. The maximum length in DOS commands is 

a. 80 chars 

b. 127 chars 

c. 100 chars 

d. 8 chars 

Correct Answer: b 

231. The time command is used to display _____ time. 

a. US time 

b. Greenwich Mean Time 

c. Julian Time 

d. System Time 

Correct Answer: d  

 

WINDOWS OPERATING SYSTEM 

1. Which button is used to increase the display of active window? 

a) Scroll box 

b) Down size 

c) Maximize 

d) Minimize 

Correct Ans: c) Maximize 

2. Where are the recycling bin option found ? 

a) On desktop 

b) On the hard drive 

c) On the shortcut menu 
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d) Properties dialog box 

Correct Ans: a) On desktop 

3.  Where are the files saved by copy command are temporarily saved ? 

a) Clipboard 

b) Printer 

c) Paste 

d) Object 

Correct  

Ans: a) Clipboard 

4. Where are deleted files saved from hard disk? 

a) Recycle bin 

b) floppy disk 

c) Mother board 

d) Clip board 

Correct Ans: a) Recycle bin 

5. Various apps and documents are shown by ______ on Windows desktop? 

a) File 

b) Label 

c) Graph 

d) Icon 

Correct Ans: d) Icon 

6. what name are the name of screen backgrounds ? 

a) App 

b) Windows 

c) Desktop 

d) Frame 

Correct Ans: c) Desktop 

7. Ms-Windows which type of software ? 

a) CUI 

b) MUI 

c) LUI 

d) GUI 

Correct Ans: d) GUI 

8. How many KB are in 1MB ? 

a) 1000 kb 

b) 1020 kb 

c) 1024 kb 

d) 1124 kb 

Correct Ans: c) 1024 kb 
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9.  What is the shortcut to open Run Dialog Box ? 

a) Alt + R 

b) Ctrl + R 

c) Window key + R 

d) Tab + R 

Correct Ans : c) Window key + R 

10. The number of pixels displayed on the screen is called the screen_______ 

a) Color Depth 

b) Viewing size 

c) Resolution 

d) Disk Rate 

Correct Ans: c) Resolution 

11. Which version of Windows does not have a START button ? 

a) WINDOWS 7 

b) WINDOWS 8 

c) WINDOWS VISTA 

d) None of these 

Correct Ans: b) WINDOWS 8 

12. Which option is used to find out the size of a file or folder ? 

a) Rename 

b) Edit 

c) Properties 

d) Customize 

Correct Ans: c) Properties 

13. What is the shortcut to delete without sending a file in the recycling bin ? 

a) Shift + Delete 

b) Ctrl + Delete 

c) Alt + Delete 

d) Alt + Ctrl + Delete 

Correct Ans: a) Shift + Delete 

 

 

14. Which company has created the windows operating system ? 

a) IBM 

b) Microsoft 

c) Sun 
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d) Google 

Correct Ans: b) Microsoft 

15. Which bar contains Start button ? 

a) Title bar 

b) Task bar 

c) Task pane 

d) Toolbar 

Correct Ans: b) Task bar 

16. By default file is saved in which of the following locations ? 

a) My computer 

b) My picture 

c) My document 

d) Desktop 

Correct Ans: c) My document 

17. What is the Shortcut to rename a file ? 

a) F1 

b) F3 

c) F2 

d) F5 

Correct Ans: c) F2 

18. Where the installed programs appears in computer ? 

a) Desktop 

b) My document 

c) Accessories 

d) All programs 

Correct Ans : d) All programs 

19. Which shortcut key is use to go from one window to another window ? 

a) Ctrl + Tab 

b) Alt + Tab 

c) Window + Tab 

d) Shift+ Tab 

Correct Ans : b) Alt + Tab 

20. What is the shortcut key to refresh ? 

a) F10 

b) F3 

c) F5 

d) F6 

Correct Ans : c) F5 
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21. What is the Extension of Notepad file ? 

a) .N.Pd 

b) .text 

c) .txt 

d) .N.PT 

Correct Ans : c) .txt 

 

22. Which option is available in Accessories ? 

a) Notepad 

b) Wordpad 

c) Calculator 

d) All of the above 

Correct Ans : d) All of the above 

23. What is the shortcut to close any program ? 

a) Alt + F4 

b) Ctrl + F4 

c) Alt + F5 

d) Alt + Esc 

Correct Ans : a) Alt + F4 

24. Data entered on the desktop is generally saved in this drive – 

a) C DRIVE 

b) D DRIVE 

c) E DRIVE 

d) F DRIVE 

Correct Ans : a) C DRIVE 

25. How many bytes are in a 1 megabyte in computer language ? 

a) 10,00,00 

b) 10,00,000 

c) 10,24,000 

d) 10,48,576 

Correct Ans : d) 10,48,576 

26. The window operating system contains a small picture , which represent 

files , folders , programs and other items, 

Every one is used to do something on the computer? 

a) Icon 

b) Taskbar 
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c) Sidebar 

d) None of these 

Correct Ans : a) Icon 

27.  Windows + F1 shortcuts are used in the windows operating system for 

______ . 

a) To open utility manager 

b) To open the Run dialog 

c) To display window help 

d)To lock keypad 

Correct Ans : c) To display window help 

28. In Microsoft window there is a graphics application named ________. 

a) Paint 

b) Adobe photoshop 

c) Notepad 

d) Wordpad 

Correct Ans : a) Paint 

29. Window + E Shortcut are used in the windows operating system for ______. 

a) To search the computer 

b) To open my computer 

c) Minimize to restore window 

d) To search the file folder 

Correct Ans : b) To open my computer 

30. Ctrl + F shortcut is used in windows operating system _______ . 

a) To search the file or folder 

b) Minimize to restore window 

c) To open my computer 

d) Computer search 

Correct Ans: a) To search the file or folder 

31. Window + L shortcut is used for _________ in the windows operating 

system . 

a) To display window help 

b) To open utility manager 

c) To lock the window 

d) To open Run dialog 

Correct Ans : b) To lock the window 

32. To minimize all window in the window operating system _______ . 

a) Windows key 

b) Windows + break 

c) Windows + D 
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d) Windows + M 

Correct ans: d) Windows + M 

 

 

 

 

33. 1In the windows operating system _______ is an area of the main screen 

that looks after the computer is on and the window log on . 

a) Windows 

b) Taskbar 

c) Icon 

d) Desktop 

Correct ans: d) Desktop 

 

 

34. Shortcuts to display or hide the start menu in windows operating system 

_______ . 

a) Windows + M 

b) Windows + D 

c) Windows + BREAK 

d) Windows key 

Correct ans: d) Windows key 

35. When you delete a file or folder in the windows operating system, then it  

does not actually delete, it goes in _________ . 

a) Dust bin 

b) Cycle bin 

c) Recycle bin 

d) None of these 

Correct ans: c) Recycle bin 

36. The Ctrl + Z shortcut in the windows operating system used for __________. 

a) Paste 

b) Delete 

c) Move 

d) Undo 

Correct ans: d) Undo 

37. In Windows operating system Shift + Arrow key used for________ . 

a) Some paste is done 
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b) One or more items are selected on windows , or the text is selected in 

the document 

c) Text or block is highlighted 

d) Something delete 

Correct ans: b) One or more items are selected on windows , or the text is 

selected in the document . 

 

38. The _______ shortcut is used to copy text or images into the windows 

operating system. 

a) Ctrl + X 

b) Ctrl + C 

c) Ctrl + D 

d) Ctrl + V 

Correct Ans : b) Ctrl + C 

39. Which shortcut key is used to cut data in the windows operating system? 

a) Ctrl + X 

b) Ctrl + D 

c) Ctrl + V 

d) Ctrl + C 

Correct Ans : a) Ctrl + X 

40.  _______ is used to store data and program. 

a) Recycle bin 

b) File 

c) Icon 

d) None 

Correct Ans: b) File 

41. Which of the following option is used to control computers and manage 

resources ? 

a) Desktop 

b) Operating system 

c) Drivers 

d) None of these 

Correct Ans : b) Operating system 

 

42. The process to run more than one application at a time is called _______ . 

a) Booting 

b) Multicopping 
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c) Multitasking 

d) Multi-pasting 

Correct Ans : c) Multitasking 

43.  The process that is started while starting the computer is called ________ . 

a) Booting 

b) Multicapping 

c) Multitasking 

d) Multipasting 

Correct Ans : a) Booting 

44.  ________ is controlled by the mouse and changes in shape based on its 

current function . 

a) Icon 

b) Desktop 

c) Pointer 

d) Program 

Correct Ans : c) Pointer 

45. What is windows, Linux, Unix, Mac ? 

a) Application Program 

b) Office Suit 

c) System Program 

d) Operating System 

Correct Ans : d) Operating System 

 

46. ______ is most commonly used Operating system . 

a) Unix 

b) Mac OS 

c) Windows 

d) Linux 

Correct Ans : c) Windows 

47.  ______ Word processor is the part of the windows operating system . 

a) Notepad 

b) Wordpad 

c) Microsoft Word 

d) Adobe photoshop 

Correct Ans : b) Wordpad 
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48. ______ Normal text editor is a part of the windows operating system 

a) Notepad 

b) Wordpad 

c) Microsoft Word 

d) Adobe Photoshop 

Correct Ans : a) Notepad 

49.  To select All the data from a file together , Which shortcut key is used ? 

a) Ctrl + S 

b) Ctrl + A 

c) Ctrl + M 

d) Window + A 

Correct Ans : b) Ctrl + A 

 
 

***The End*** 

 

 

 


